General Supply Warehouse: A Case Study in Internal Control Assessment and IT Auditing Software

James Hall¹ | Kallie Ziltz²

Technology is changing the auditing paradigm. As such, future accounting graduates are expected to have substantial technological skills. The proposed case provides students with an authentic scenario in which to apply such skills. Revenue and expenditure processing procedures are described for General Supply Warehouse, and several pertinent data files are also included. Students are required to conduct a thorough analysis of internal controls, identify associated weaknesses and utilize either ACL or IDEA to perform substantive testing. Data provided with the case have been engineered to produce measurable results from the pre-specified audit tests. The instructor’s section of the case contains comprehensive solutions and a suggested implementation plan.

KEYWORDS
Risk, Internal Control, Substantive Tests, Database, Fraud, ACL, IDEA, IT Auditing

¹Lehigh University, College of Business and Economics, United States
²Lehigh University, College of Education, United States

Correspondence
Kallie Ziltz, Department of Teaching, Learning and Technology, Bethlehem, Pennsylvania, 18015, United States
Email: krz216@lehigh.edu

Received 10 July 2018; Received in revised form 13 October 2018; Accepted 15 October 2018

1 | THE FUTURE OF COMPUTER AUDITING EDUCATION

It is news to very few in the accounting profession that a technology revolution is reshaping the audit process. The drivers of this transformation include technologies such as data analytics tools, artificial intelligence (AI), and blockchain. Not only are these technologies promising to change how future audits will be conducted but also how public accounting firms will be structured in the near future. By automating entry-level audit tasks, the classical pyramid shape of the CPA organization will be transformed into a diamond-shaped structure. With fewer entry level positions to be filled, firms will focus on hiring experienced staff and domain experts. Although the audit function will continue into the future, it will change significantly. Successful future university graduates will be those who emerge from their educational programs in possession of salable technical skills and the business acumen to analyze results and make appropriate decisions (Stough, 2018).

The future of computer auditing education must reflect the direction the auditing profession is taking. The auditing paradigm is shifting drastically to require the use of technology. Where traditional accounting courses may not provide this connection with technology, there is an opportunity for accounting information systems (AIS) or IT Auditing courses to embrace relevant technology to better prepare our students.

It is not enough, however, to simply demonstrate relevant auditing software to students. Rather, they need extended time to master the technology and apply the given functionality in a meaningful way. The GSW case, described in its entirety below, is an authentic, risk-based approach to auditing and internal controls that creates a unique opportunity for accounting students to learn and apply accounting concepts with technology to make deeper, more meaningful connections.

2 | INTRODUCTION TO THE GSW CASE

To address the need for authentic and hands-on computer auditing instruction, we have designed a realistic internal control and IT audit case for a hypothetical company called General Supply Warehouse (GSW), which supplies a line of commercial products to industrial customers. The case has the following learning objectives:

- To reinforce the students understanding of the relationship between internal controls, accounting risks, and substantive tests.
- To develop hands-on skills with ACL or IDEA software in the design and execution of common audit tests.
- To deepen the students understanding of data structures within a relational database environment, which is central to many IT audit and data analytics issues in accounting.

The intended audience for the case is students who are currently enrolled in or have completed an accounting information systems (AIS) course and are familiar with common business processes and internal control principles.

The case scenario describes GSW’s revenue cycle and expenditure cycle business processes. Based upon this description and the data files that accompany the case the goal is to perform certain tasks related to IT auditing. First among these is to conduct an analysis of GSW’s internal controls. To assist students in this task, the GSW Case Appendix A provides a...
description of internal control issues and examples that will serve as a framework for applying them. In addition, the case requires students to design and conduct several audit tests on the included data files using either ACL or IDEA software. In preparation for this part of the case, therefore, students should become familiar with the basic commands and operation of ACL or IDEA through the tutorials that accompany the educational versions of those products.

Additional resources, including a PowerPoint presentation outlining common ACL and IDEA commands, are available at the GSW Website: https://sites.google.com/view/gsw-case/.

Reviews of relevant accounting and auditing education literature (Apostolou, Dorminey, Hassell and Rebelle, 2013, 2014, 2016) indicate that most internal control and audit teaching cases have focused on the application of the Committee of Sponsoring Organizations of the Treadway Commission (COSO) internal control framework in an isolated rather than integrative manner. An exception to this trend is the TJX case presented by Cereola and Cereola (2011), in which students are asked to apply COSO with a focus on computer controls, data security, and privacy legislation. Guo and Eschenbrenner (2018) also presented a case focused on internal control considerations within the broad context of risk management. These cases, however, do not push students past the theoretical point of internal control analysis. In contrast, the GSW case challenges students to go beyond this analysis to include the design of substantive tests based on identified control weaknesses and unmitigated risks.

Beyond creating deeper connections to important computer auditing concepts such as internal controls and substantive testing, students completing the GSW case will also obtain hands-on experiential learning in the execution of such substantive tests using industry-relevant software packages. Specifically, the GSW case was designed and written using the ACL and IDEA software packages. ACL offers an audit management software that incorporates integrated analytics ("ACL Solution," n.d.). Similarly, IDEA, supported by CaseWare Analytics, is a data analysis tool designed to support audits ("IDEA," n.d.). While other data analysis tools may be used to solve the GSW case, instructions and case solutions are provided only for ACL and IDEA.

A review of published case studies identified one similar to the GSW case that also utilizes IDEA software to complete the assignment. Students are tasked with using IDEA to identify red flags of potential management fraud that may have been perpetrated in the preparation of manual journal entries by overriding existing internal controls (Fay & Negangard, 2017). Although both cases use industry-relevant software, the GSW case differs from the Fay and Negangard (2017) case in two material ways. First, the GSW source data files contain detailed transaction data, rather than summary journal entries. Second, the case presented by Fay and Negangard presumes a system of otherwise effective internal control, which management overrides. In contrast, the GSW case describes a system of weak controls that students analyze in terms of unmitigated risks that could result in errors in specific account balances and increase the potential for fraud. Based on their analysis, students then design and implement substantive tests using IDEA or ACL. Through the presentation of a flawed system of internal controls, students experience a meaningful and unique opportunity to practice authentic auditing skills, while also learning about an industry-relevant audit technology solution.

An important educational consideration, especially related to the incorporation of technology within instruction, is whether an assignment elicits meaningful learning. Described by Howland, Jonassen, and Marra (2012), tasks that elicit meaningful learning are characteristically active, constructive, intentional, authentic, and cooperative. In general, relevant technology can help achieve more meaningful learning by supporting these characteristics. Considering the GSW case as it relates to the characteristics of meaningful learning:
1. **Active:** The case requires that students are completely active. Rather than describing the COSO Framework, internal control objectives and realistic examples from business, students are provided with detailed descriptions of a current system of internal controls. They are tasked to apply prior knowledge of internal controls and business processes in order to assess the control environment of the hypothetical company as well as perform the required substantive testing.

2. **Constructive:** The G37 case allows students to individually apply accounting concepts that they have learned in order to address a common goal. This process allows students to create meaning for themselves and make direct connections between concept and application. Unlike traditional accounting cases that are based on structured, aggregated general ledger data, the G37 case requires students to analyze flat transaction data files and draw out intelligence from the information held within them.

3. **Intentional:** Although the G37 case guides the audit that students are asked to complete, students may find that there is more than one way to approach each requirement.

4. **Authentic:** The G37 case uses realistic details and financial data. The challenges presented for each business cycle require that students design and complete real substantive tests. This provides an authentic opportunity that students would have previously only read about. Further, IDEA and ACL are examples of data analysis and audit-support software that are used by accounting firms ("ACL Solution," n.d.; "IDEA," n.d.). Incorporating these software packages into the case provides students with an authentic auditing experience similar to one they may be tasked with after graduation.

5. **Cooperative:** Although students should complete assignments individually, they are encouraged to collaborate with their peers, professor, and teaching assistant(s). There is more than one way to solve each assigned problem, and as such, they may find that they have taken a different approach than someone else. Also, depending on the experience level of students, an instructor may choose to assign them to audit teams and offer the case as an open-ended team project rather than assigning the specific questions that come with the case. This modification would allow teams to assess G37 control weaknesses, design relevant substantive tests and implement them accordingly.

### 3 | GENERAL SUPPLY WAREHOUSE CASE STUDY

#### 3.1 | **Background**

With a product line that ranges from sump pumps to safety glasses, General Supply Warehouse (G37) has established a reputation as a reliable vendor of quality commercial products at competitive prices. G37’s customer base consists of industrial businesses throughout the United States and Canada with corporate offices situated in its Los Angeles warehouse. The company purchases inventories directly from the manufacturers.

G37 currently employs a client-server networked accounting system, which it purchased from Flybynite Custom Applications (FCA), Inc., in 2014. FCA’s lead systems designer, James Smith played a central role in implementing and customizing the system to G37’s specific needs. G37 subsequently hired Smith to oversee system operations and ensure a smooth transition from their old legacy system. Six months after a successful implementation G37’s CEO promoted Smith to Warehouse Operations Manager.

G37 is currently undergoing its annual audit and you are the in-charge auditor responsible for assessing G37’s revenue
and expenditure cycle controls, and related accounts. The following describes GSW’s business processes:

### 3.2 Sales and Cash Receipts Procedures

All sales to customers are net/30, FOB shipping point. The flowchart in Figure 1 and the record layout in Figure 2 illustrate GSW’s sales and cash receipts procedures.

**Sales Department**

The sales department receives customer orders by hard copy mail or fax. Upon receipt of the order, a member of the sales staff accesses the customer record and reviews the available credit before creating a Sales Invoice record. For customers with insufficient available credit, the clerk refers the order to Sally Kwan, the credit manager, for approval. If granted, then Sally verbally authorizes the clerk to increase the customer’s line of credit. For approved sales, the clerk creates a record in the Sales Invoice file via his terminal in the department. The system automatically assigns an Invoice Number, which is the primary key for the record, however, it does not facilitate automated data entry. The clerk must therefore manually enter the transaction details into the Sales Order record including Product Number, Sales Price, Quantity, Amount Due, and Sales Date.

**Warehouse**

Triggered by the sales invoice the system automatically prints a stock release document on the warehouse terminal, which a member of the warehouse staff uses for picking the goods. The clerk then sends the goods, along with the stock release document, to the Shipping Department. Once the goods leave the warehouse, the warehouse clerk adjusts the Quantity on Hand field of the respective record in the inventory file to reflect the units sold.

**Shipping Department**

The shipping department clerk receives the stock release and the inventory, prepares them for shipment, selects a carrier and prints the packing slip and bill of lading (BOL). The clerk then adds a record of the shipment to the Shipping Log file and physically hands over the goods to the carrier. Assuming no unusual circumstances, sales orders received by 2 PM are shipped the same day. Items received by shipping after 2 PM are shipped the following day.

**Billing**

At the end of the day, the system automatically searches the Sales Invoice file for records added to the file that day and prints hard copy customer invoices and remittance advices, which a clerk mails to the customers. The system automatically calculates due dates based on net/30 terms of trade and places them in the Due Date fields of the respective Sales Invoice records.

**Cash Receipts**

Maria Perez, the cash receipts clerk, receives the customer checks and remittance advises directly from the customer. She begins by creating a record in the Cash Receipts file to which the system automatically assigns a Remittance Number as the primary key. Then, using the invoice number (taken from the hard copy remittance advice) as a search key she locates the appropriate invoice in the Sales Invoice file and manually adds the remittance Number to a field in the record. This closes the invoice and marks it paid. Maria also adds the Invoice Number from the invoice record to the cash receipts record as a cross reference. She then manually adds the customer number, amount, and payment date to the Cash Receipts record. At the end of the day, she prepares a deposit slip and sends the checks to the bank. She files the remittance advices in her office. The Sales Invoice file serves to calculate both total sales for the period and...
3.3 | Purchasing and Payment Procedures

All purchases from suppliers are FOB destination. The flowchart in Figure 3 and the file structure diagram in Figure 4 illustrate the purchasing/payment procedures at GSW.

Warehouse

Each morning James Smith reviews an automatically generated inventory status report from his office terminal. He determines the items that need replenishing and selects suppliers from the Vendor file, which he maintains. Smith then adds a record to the purchase order file. The system assigns each new record a unique number (PO Number) as the primary key. Smith manually enters the date, the product to be ordered, order quantity, expected unit cost (the extended cost is automatically calculated by the system), and the ID (Ven-Num) of the selected vendor. Smith then prints the purchase orders from his terminal, signs them, and has his secretary mail them to the respective suppliers.

Receiving

The warehouse receives supplier orders directly where Smith, or one of the warehouse employees, counts and inspects the items and reconciles the order with the attached packing slip. The receiving clerk then adds a record to the Receiving Report file from the warehouse terminal. The system assigns a unique key (RR Num) to each record. The clerk manually enters the purchase order number, product number(s), quantity received, vendor ID number, and the date of receipt. The clerk then files the packing slip in the warehouse. Finally, the clerk updates the quantity on hand filed in the inventory subsidiary ledger to record the receipt of the goods.

Accounts Payable

James Jefferson, the Accounts Payable clerk receives the vendor’s hard copy invoice and, using the PO number from the invoice as a search key, he matches the invoice with the corresponding purchase order. James then creates a record in the Voucher Payable file. The system assigns a unique key (Voucher Number) to each record. The clerk manually enters the following data directly from the supplier’s invoice: purchase order number, vendor number, supplier invoice number, full amount due, discounted amount due, and due date. Finally, Jefferson files the hard copy vendor invoice in the office filing cabinet.

Cash Disbursements

Each day, Greg Orlando in the Cash Disbursements department reviews the Voucher Payable file for items due for payment that day. For each item due, he adds a record to the Check Register file. The system assigns it a unique key (Chk Num) and Greg manually adds the following data to the Check Register record: voucher number, vendor number, amount of payment, and date. The system automatically places the check number in the appropriate Voucher Payable record to close the voucher and mark it paid. The checks are printed in Greg’s office and then sent to the vendor.

Data in the Voucher Payable file is the basis for calculating both total purchases for the period and accounts payable. The total of the Full Amount field constitutes total purchases for the period. Items in the file that are unpaid (still open) at period end are accounts payable.
FIGURE 1  GWS Sales Order and Cash Receipts Procedures

FIGURE 2  GWS Sales and Cash Receipts Files Structure
FIGURE 3  GWS Sales Order and Cash Receipts Procedures

<table>
<thead>
<tr>
<th>Inventory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Num</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Vendor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ven Num</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chk Register</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chk Num</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Voucher Payable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voucher Num</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Receiving Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>RR Num</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Purchase Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO Num</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Employee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empno</td>
</tr>
</tbody>
</table>

FIGURE 4  GSW Sales and Cash Receipts Files Structure
4  |  REVENUE CYCLE REQUIREMENTS

4.1  |  Internal Control and Risk Assessment

Based on the case description and the revenue cycle flowchart (Figure 1):

(a) Discuss GSW’s internal control weaknesses.
(b) Describe the unmitigated risk(s) associated with each control weaknesses.
(c) Comment on the possible misstatement in specific accounts due each control weakness.

Use the six control activities described in the Appendix as a framework for your responses.

4.2  |  Substantive Tests and Risk Assessment

First, download the Excel source data files to create an ACL or IDEA project. These files are available on the GSW Website: https://sites.google.com/view/gsw-case/. From the “Source Files” page, you can find detailed instructions for converting the source files into an ACL or IDEA project. The data contained in these source files correspond to the file structures depicted in Figures 2 and 4.

Using relevant revenue cycle data files and selected financial data provided below, perform the following substantive tests and prepare a report of your findings (including screenshots from ACL or IDEA).

(a) Verify the reported sales figure.
(b) Recalculate AR.
(c) Perform an Aging of AR and assess the reasonableness of the Allowance for Doubtful Accounts.
(d) Verify that Sales and related customer cash receipts are accurately recorded.

Selected GSW Financial Data

<table>
<thead>
<tr>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>21,519,987.84</td>
</tr>
<tr>
<td>Accounts Receivable</td>
<td>19,009,030.80</td>
</tr>
<tr>
<td>Allowance for Doubtful Accounts (.02 x Sales)</td>
<td>(430,399.75)</td>
</tr>
<tr>
<td>Net Accounts Receivable</td>
<td>18,578,631.05</td>
</tr>
</tbody>
</table>
5  |  EXPENDITURE CYCLE REQUIREMENTS

5.1  |  Internal Control and Risk Assessment

Based on the case description and the expenditure cycle flowchart (Figure 3):

(a) Discuss GSW’s internal control weaknesses.
(b) Describe the unmitigated risk(s) associated with each control weaknesses.
(c) Comment on the possible misstatement in specific accounts due each control weakness.

Use the six control activities described in Appendix A as a framework for your responses.

5.2  |  Expenditure Cycle Substantive Tests

Using relevant expenditure cycle data files as well as financial data provided below, perform the following substantive tests and prepare a report of your findings (including screenshots from ACL or IDEA).

(a) Identify unrecorded liabilities.
(b) Verify that the inventory balance is reported at net realizable value.
   Reported Financial data: Inventory Balance at 12/31/2017 = 6,321,164.32
(c) Verify that payments to vendors accurately reflect the amounts that were owed.

6  |  FRAUD DETECTION REQUIREMENTS

Based on your analysis of GSW’s internal controls, and the data files in the GSW project, design and perform tests to reveal the potential for fraud in the company. To assist you in this task, GSW Case Appendix B provides a review of common fraud schemes and corresponding ACL and IDEA techniques that can be used to detect them.

Prepare a report of your findings including screen shots of your test results.
7 | NOTES FOR INSTRUCTORS

7.1 | Case Structure

The case is comprised of the three sections. First, detailed description of the revenue and expenditure cycle business processes is provided for GSW. This description includes a written narrative, system flowcharts, and record structures for the data files that are included with the case. Seeded within the description are material internal control weaknesses. Students are required to evaluate the documentation provided, identify the internal control weaknesses, and assess the unmitigated risks associated with them. GSW Case Appendix A provides a review of internal control objectives and techniques based on the COSO internal control model, as a framework to assist in this task. A comprehensive copy of this description (including both appendices) are available from the “General Supply Warehouse” page on the GSW case website (https://sites.google.com/view/gsw-case).

Next, students are required to use common features of ACL or IDEA software including joins of multiple tables, Benford’s analysis, tests for gaps and duplicate records, as well as other analytic tools to perform specified substantive tests and tests for fraud. To accomplish these tasks, source data files in Excel format accompany the case. Students will convert these flat data files into an ACL or IDEA project. The "Source Files" page on the GSW case website (link provided above) provides detailed instructions for conversion and 11 Excel files containing GSW transaction and master data.

Finally, comprehensive solutions (in the form of PowerPoint presentations) for the internal control and the ACL or IDEA related questions accompany the case. Simplified versions of both the IDEA and ACL solutions are included in this article. They are also available for download from a Google Drive folder (https://goo.gl/5GFjaV) as well as a secure area on the case website (link provided above). Use the top navigation bar to access the “Solutions” page of the website where you may request access to the case solutions through a Google Form. Within a day or two of your request, you should receive access privileges for both the ACL and IDEA versions of the case.

7.2 | Proposed Instructional Plan

Preparation for the GSW Case

For Instructors. Before implementing the GSW Case in a computer auditing course, instructors should choose which software package the students will use to complete the audit process. As mentioned previously, we suggest either ACL or IDEA audit support packages. Once a particular technology is chosen, instructors should check the install and licensing process specific to their institution. Case completion works best when students can install the software locally onto their computers and work at their own convenience. If this is not an option due to licensing constraints, we suggest that students are provided suggested lab time to meet and work on the project using public sites computers (where the software is provided). Although inconvenient, this would not affect the effectiveness of the case.

Instructors should also familiarize themselves with the technology by completing guided tutorials. There are many resources available on both the ACL and IDEA websites to utilize. We finally suggest that instructors should complete the GSW case to understand the steps required to solve each problem. This may also help identify and anticipate struggles that their students may encounter.
For Students. Before the GSW Case is assigned, students should set up their computer auditing environment as directed by the course instructors. Once students have either IDEA or ACL available to them, we suggest that they next complete a guided tutorial to introduce them to the software package. We have found that best results are achieved when implementation is preceded by a guided tutorial and/or a short introduction to the software intended to highlight important commands and features. Before asking students to complete the GSW case in its entirety, it is important to provide them with adequate information about the technology itself. The intention is that using an unknown technology should not hinder the learning process. Students should be required, or at least strongly recommended, to walk through a guided tutorial for the software. Tutorial exercises that accompany the educational versions of IDEA and ACL are an excellent means for familiarizing students with the software.

Following a guided tutorial, we next recommend that instructors introduce students to the basic functionality of the software being employed as well as small examples of its use in the conduct of an audit. Towards this end, the GSW website contains PowerPoint presentations of common ACL and IDEA commands with examples of their application. We have found that this helps students contextualize the functionality they learned through the tutorial and apply it in an authentic audit scenario.

Beyond the audit technology, other important content knowledge pertinent to student success with the GSW case includes a basic understanding of the following AIS concepts:

- Business Cycles: Students should understand how both the revenue and expenditure cycles should function. They should understand the role of standard functions and departments such as sales, billing, accounts payable, and receiving, as well as the accounting information (documents) that trigger these activities. Students should also be familiar with common risks associated with the revenue and expenditure cycles such as selling to non-creditworthy customers or false payments to vendors because of fraud or errors.
- Internal Controls: Students should understand basic internal control techniques employed by management to mitigate the risks above such as the need for credit checks to control customer sales and a three-way-match to control cash payments to vendors.
- Relational Databases: Although students are not presented with a relational database and are not asked to create an entity-relation diagram for GSW, they will use relational knowledge to complete substantive testing. For example, to verify that a three-way-match was performed on cash disbursements students need to understand the relationship between the Purchase Order, Receiving Report, and Vendor Invoice and how to join these tables on a common attribute (PO-INV).
- Flowcharts: For this case, students should understand how to interpret system flowcharts. Within the case, there is both a textual description of GSW’s procedures as well as a visual depiction of each business cycle in the form of a system flowchart. Further, students are provided with a diagram of the data files structures that depict important relationships between the files.
- Common types of fraud: Students should understand common types of fraud. To support this content (as well as the questions specifically related to this topic), we have included GSW Case Appendix B, which summarizes several common fraud schemes and outlines ACL and IDEA commands and techniques used for fraud detection.
At this point, students are ready to be introduced to the case. They should review the case description and also download the source data Excel files and create an audit package in either IDEA or ACL. As described in the case requirements, instructions to do this are available on the case website (https://sites.google.com/view/gsw-case/) on the “Source Files” page.

**Implementing the GSW Case.** After following the preparation guidelines described above, instructors should be ready to facilitate the case and students should be ready to complete it. Here, we describe a suggested plan of implementation. First, following the short introduction to important functions in either ACL or IDEA (as described above), instructors will introduce students to the basic details and purpose of the GSW case. We suggest that instructors require students to read the case description before this discussion.

Next, the instructor should assign the Revenue Cycle as the first GSW assignment. If deemed necessary, the instructor may consider reviewing important supplemental accounting knowledge required to complete the questions. Relevant concepts may include principles of revenue recognition as well as how to identify accounts receivable for a given period. A more complete description of these concepts is provided in the Instructor’s Appendix A. We suggest allowing students three to five days to complete each part.

After students submit their responses to the Revenue Cycle requirements of the GSW Case, instructors might consider reviewing the solutions during class. This may help address any questions or concerns that students had related to the case or technology. Next, the instructor should assign the Expenditure Cycle as the second GSW assignment. Again, the instructor may consider reviewing important supplemental accounting knowledge required to complete the questions. Relevant concepts may include defining unrecorded liabilities and identifying accounts payable for a given period. A more complete description of these concepts is also provided in the Instructor’s Appendix A. We suggest allowing students three to five days to complete this assignment.

Following student submissions of the Expenditure Cycle requirements of the GSW Case, instructors might consider reviewing the solutions during class. This may help address any questions or concerns that students had related to the case or technology. Next, the instructor should assign the Fraud Cycle as the third and final GSW assignment. **GSW Case Appendix B** provides students with supplemental content defines common fraud schemes and identifies detection techniques that may be used during an audit. Instructors may choose to review these concepts, or if previously covered during lecture, they can simply provide the appendix to the students. We suggest allowing students three to five days to complete this part also.

Following the final submission of the Fraud assignment, instructors may again review solutions during class. At this point, we have found an open class discussion to be useful in obtaining student feedback regarding the audit process and lessons learned related to the case scenario, requirements and the ACL or IDEA technology.

**Teaching Tips for the GSW Case**

Versions of this case have been classroom tested in both undergraduate-level Accounting Information Systems and graduate IT Auditing courses. As suggested in the instructional implementation plan above, we have found that the case is most effective when assigned to students in three separate parts. Further, it helps most if the timing of the case is such that each assignment (Revenue, Expenditure, and Fraud) is assigned soon after students learn about each topic in lecture. If this is not possible, we suggest waiting until after all three areas are covered before introducing the case to the students.
Qualitative feedback from students regarding the rigor of this case has typically reflected their difficulty in reconciling the classical accounting concepts that underlie the case with the physical data structures and file types found in computer-based accounting systems. Depending on the structure and student makeup of the class, scaffolding the GSW case with supplemental accounting information may or may not be required. We have found that for most students, especially younger undergraduate students, reviewing accounting concepts and file structure conventions presented in Instructor’s Appendix A, prior to assigning the case is beneficial in helping students navigate the case.

Other feedback from students has indicated that the learning curve required to use a new software, such as IDEA or ACL, may be steep. We have found success with through dedicated lab time or office hours that are held either by the instructor or a qualified Teaching Assistant. With “real-time” technical assistance available, students typically quickly become comfortable with the new technology and are able to focus more specifically on the case content. Another technique that we use to improve the effectiveness of the case is to encourage students to plan out the steps they will use to complete each substantive test before they take to ACL or IDEA. Rather than clicking aimlessly or just guessing-and-checking solutions, this strategy helps students apply accounting concepts first, before having to implement in the software.

Only after an adequate risk-based discussion of important internal control considerations within each transaction processing (business) cycle should students be assigned the case. It is important not to overwhelm the students with new material, and to specifically keep the assignment within a student’s zone of proximal development (ZPD). Originally developed by Vygotsky, the zone of proximal development is defined as:

 [...] the distance between the actual developmental level as determined by independent problem solving and the level of potential development as determined through problem solving under adult guidance, or in collaboration with more capable peers (as cited in Bransford, Brown and Cocking, 2000, p. 81).

Essentially, the idea is that assignments should be challenging but not overwhelming. The use of realistic and detailed financial information for GSW guarantees that assigned tasks are challenging enough. Consequently, scaffolding in the form of timing of assignments, presentation of supplemental material, dedicated lab time or office hours, as well as suggested planning procedures for each substantive test will help ensure that students are not overwhelmed by the assignment. Within their zone of proximal development, students are provided with the best opportunity to apply concepts in order to make meaningful connections and gain saleable skills in IT Auditing.

8 | GENERAL SUPPLY WAREHOUSE SUGGESTED GRADING RUBRIC

8.1 | Revenue Cycle Responses

1. 10 points: Discussion here should include physical controls as described in the COSO Framework, including transaction authorization, segregation of duties, access, etc.
   a. Full Credit if there is a thorough discussion of the revenue cycle internal controls.

2. 20 points: Each part in this section (a-d) is worth 5 points.
   a. 5 points: Students should join sales invoice and shipping log and filter out records that were shipped after the end of the year.

*International Journal of Computer Auditing, Vol.1, No.1, Publication date: Spring 2019*
i. Actual sales is 21,269,881.44.
ii. **Full credit** if their sales amount is +/- 100,000 and they described the fact that the reported sales were overstated.

b. **5 points**: To the previous table, students join cash receipts.
   i. Students should find that the AR value is 18,936,407.
   ii. Students should also recalculate AFDA based on the new sales figure found in part a, and subtract this value from 18,936,407 to find the net AR value of 18,511,010.
   iii. **Full credit** if the AR/AFDA/Net AR values are within +/- 100,000 and the student finds net AR.
   iv. **Half credit** if student only finds gross AR.

c. **5 points**: Students should perform aging on the AR table created in part b.
   i. A large percentage of GSW AR are more than 90 days past due (i.e. more than 0.02); If the auditor acknowledges that these accounts are likely uncollectible, he/she would question the reasonableness of the current AFDA percentage.
   ii. **Full credit** if the student draws a reasonable conclusion based on some assumption about bad debts. (For example, if they say that GSW would consider all debts 120 days outstanding uncollectible, the current AFDA value seems reasonable).
   iii. **Half credit** if the student just says that the AFDA value is unreasonable without any explanation.

d. **5 points**: The student should find at least 6 entries with a discrepancy in payment.
   i. **Full credit** if the student explains that the discrepancies may be from fraudulent activity OR user error in data entry.
   ii. **Half credit** if the student says that all discrepancies represent fraud.

### 8.2 | Expenditure Cycle Questions

1. **10 points**: Discussion here should include physical controls as described in the COSO Framework, including transaction authorization, segregation of duties, access, etc.
   a. **Full Credit** if there is a thorough discussion of the expenditure cycle internal controls.

2. **15 points**: Each part in this section (a-c) is worth 5 points.
   a. **5 points**: There are 13 unrecorded liabilities, valued at 43,908.88.
      i. **Full credit** if student finds total of unrecorded liabilities within +/- 10,000.
      ii. **Half credit** if student goes through the correct steps, but the answer is off by more than 100,000.

   b. **5 points**: Net realizable value is defined as the lower of cost or market value for each item in inventory. NRV is 4,422,554.
      i. **Full credit** if student finds the correct NRV value, or a value within +/-100,000.
      ii. **Half credit** if student goes through the correct steps, but the answer is off by more than 100,000, or if they don't conclude that the reported inventory value is overstated.
      iii. **Partial Credit** (-3) if the student finds NRV by finding the lower of cost or market overall rather than per item.

   c. **5 points**: To verify payments to vendors, students should at least search for checks written for incorrect amounts. They may also find duplicate payments.
      i. **Full credit** if the student finds at least the two entries in which the check amount differed from amount due (both discount and full).
ii Partial credit (-1) if the student only finds one of the two entries of inaccurate payments to vendors.
iii Half credit if the student only finds the two duplicate payments.

8.3 Fraud Responses

1. 10 points: Benford's Analysis.
   a. Full credit if the student performs Benford’s analysis on sales invoice and finds that the invoice values do not fall in the expected ranges.
   b. Half credit if the student performs a Benford’s analysis on other tables (not including sales invoice).
2. 10 points: Testing for Vendor Fraud.
   a. Full credit if the student at least compares the vendor and employee tables to find possible sources of fraud.
   b. Half credit if the student only summarizes the voucher payable table to find one vendor is owed significantly more than other vendors (but does not compare the employee and vendor tables).

9 GSW COMPREHENSIVE SOLUTION

As mentioned previously, instructors may access PowerPoint presentation of the GSW solutions from the case webpage or through Google Drive. Both versions of the solutions are presented in the following pages.

9.1 Revenue Cycle Internal Control and Risk Assessment Solutions

Based on the case description and the revenue cycle flowchart (Figures 1):

(a) Discuss GSW’s internal control weaknesses.
(b) Describe the unmitigated risk(s) associated with each control weaknesses.
(c) Comment on the possible misstatement in specific accounts due each control weakness.

The enumerated responses on the following pages correspond to the numbered circles in the flowchart below:
1) Inadequate Credit Check Process  
   a. **Internal Control Weakness**: There is a lack of transaction authorization here. Credit approval of customers is provided verbally and informally. Under the current procedures, a sales clerk could extend credit without management approval.  
   b. **Unmitigated risk**: Sales may be made to non-creditworthy customers, which results in excessive bad debts.  
   c. **Possible account misstatements**:  
      - AR is overstated.  
      - Allowance for Bad Debts is understated.  
      - Bad Debt Expense Understated.  
      - Revenue is overstated.

2) Lack of Computer Controls over Creation of Sales Invoice  
   a. **Internal Control Weakness**: Due to inadequate system functionality and computer controls sales clerks are required to manually enter sales transaction details including sales prices, quantities, and calculate the amounts due.  
   b. **Unmitigated Risk**: This environment lends itself to clerical errors in the creation of sales invoice records.  
   c. **Possible account misstatements**:  
      - Sales is incorrectly recorded  
      - AR is incorrect recorded.  
      - Bad Debt Expense incorrect.

3) Potential Errors in Recognizing Sales
a. **Internal Control Weakness**: The system prepares hard copy sales invoices based only the existence of a record in the Sales Invoice file without verification that the ordered products were actually shipped.

b. **Unmitigated Risk**: Recognizing sales before they are shipped (realized) is contrary to accounting theory and may result in the following end of period errors.

c. **Possible account misstatements**:
   - Sales are overstated.
   - AR is overstated.
   - Allowance for Bad Debts is understated.
   - Bad Debt Expense is understated.

4) Warehouse Asset Custody

a. **Internal Control Weakness**: Segregation of duties are lacking here. The warehouse staff have custody of inventory and record keeping responsibility for updating the inventory subsidiary ledger.

b. **Unmitigated Risk**: Because the warehouse clerks have access to the accounting records they may conceal inventory losses and thefts.

c. **Possible account misstatements**:
   - Inventory understated.
   - Cost of Goods Sold (COGS) overstated.

5) Custody of Cash Assets

a. **Internal Control Weakness**: There needs to be better segregation of duties here. The cash receipts clerk has custody of cash and record keeping responsibility for posting payments to open invoices.

b. **Unmitigated Risk**: The current transaction processing procedures increase the risk of errors such as posting incorrect amounts or posting to the wrong invoices. The risk of frauds such as skimming or lapping also exist.

c. **Possible account misstatements**:
   - Cash Receipts understated.
   - Accounts receivable overstated.

6) Lack of Computer Controls over Recording Cash Receipts

a. **Internal Control Weakness**: Due to inadequate system functionality and computer controls the cash receipts clerk is required to manually enter cash receipts transaction details including Remittance Num, Customer Num, Amount, Payment Date to the Cash Receipts record.

b. **Unmitigated Risk**: This environment lends itself to clerical errors in the creation of cash receipts records.

c. **Possible account misstatements**:
   - Discrepancies between customer amounts owed in Sales Invoice records and remittance amounts recorded in corresponding Cash Receipts records.

9.2 | **Revenue Cycle Substantive Tests Solutions (IDEA)**

A. **Verify Sales Figure (21,519,987.84)**

a. Students will join Sales Invoice and Shipping Log on Invoice Number, selecting “Matches Only." This will remove sales invoice records that have not yet been shipped.

b. Next, filter out records shipped after 12/31/2017 with the following equation: `Ship-Date < ‘20180101’`.

c. Field Statistics on `Amount-Due = 21,269,881.44` (screenshot below).

Result: Sales are overstated by 250,106.40.

*International Journal of Computer Auditing, Vol.1, No.1, Publication date: Spring 2019*
B. Verify Reported AR Balance (18,578,631.05)
   a. To the previously joined Sales Invoice and Shipping Log files, join Cash Receipts on Invoice Number, including "All Records in Both Files".
   b. To obtain AR as of the cutoff date, create a filter to include only invoices that are yet unpaid for the audit period (as of 12/31/17) and those paid after 01/01/18. To do this, use the following expression: Remit-Num == "0" OR Payment-Date >='20180101'.

| Field Statistics on Amount-Due to obtain the AR balance | 18,936,407 |
| Allowance for Doubtful Accounts (.02 x Sales) | (430,399.75) |
| Net Accounts Receivable | 18,578,631.05 |
| Result: AR is overstated by | 67,621 |

C. Perform Aging of AR
   a. Using the Aging feature on the newly calculated AR table, you will see that a large percentage of GSW Accounts Receivable are more than 90 days past due (screenshot below).
   b. Red Flag: Further Investigation is needed. Auditor would likely question the collectability of these accounts and the appropriateness of the allowance for doubtful accounts (bad debt).

D. Test the Accuracy of Sales and Cash Receipts Transactions
   a. Join Sales Invoice, Shipping Log and Cash Receipts on Invoice-Num, selecting “All Records in Both Files”.
   b. Search for discrepancies between amount due and amounts paid using the following expression: Amount > 0 AND Amount <> Amount-Due.

Result: Six records reveal discrepancies between amounts due and the amounts paid.
9.3  |  Revenue Cycle Substantive Tests Solutions (ACL)

A.  Verify Sales Figure (21, 519, 987.84)
   a.  Students will join Sales Invoice and Shipping Log on Invoice Number.
      i.  Primary Table: Sales-Invoice, Secondary Table: Shipping Log.
      ii. Primary and Secondary keys: Invoice Num.
      iii. Primary and secondary fields: "Add all".
   b.  Next, filter out records shipped after 12/31/2017 with the following equation: Ship-Date < ‘20180101’.
   c.  Field Statistics on Amount-Due = 21,269,881.44 (screenshot below).
      Result: Sales are overstated by 250,106.40

B.  Verify Reported AR Balance (18,578,631.05)
   a.  To the previously joined Sales Invoice and Shipping Log files, join Cash Receipts on Invoice Number.
      i.  Primary and Secondary keys: Invoice Num.
      ii. Matched Primary records: Include all primary and secondary records.
   b.  In the new table, change Remit-Num type from ASCII to Numeric.
      i.  Edit > Table Layout > double-click on Remit-Num.
   c.  To obtain AR as of the cutoff date, extract or filter to include any invoices that are yet unpaid for the audit period (as of 12/31/17) and those paid after 01/01/18. To do this, use the following expression: Remit-Num == 0 OR Payment-Date >= ‘20180101’.

      Analyze > Total Fields on Amount-Due to obtain the AR balance 18,936,407
      Allowance for Doubtful Accounts = .02 * 21,269,881 (0.02 of recalculated sales) = (425,397)
      Net Accounts Receivable 18,511,010
C. Perform Aging of AR
   a. Using the Aging feature on the newly calculated AR table, you will see that a large percentage of GSW Accounts Receivable are more than 90 days past due (screenshot below).
   b. Red Flag: Further Investigation is needed. Auditor would question the collectability of these accounts and the appropriateness of the allowance for doubtful accounts (bad debt).
   c. Using Sales-Invoice table, Analyze > Age
      i. Age on Sales-Date.
      ii. Change cut-off date to 12/31/17.
      iii. Subtotal fields on Amount-Due.
      iv. Change intervals to include 30, 60, 90, 120, 150, 180, and 210.

Result: AR is overstated by 67,621

International Journal of Computer Auditing, Vol.1, No.1, Publication date: Spring 2019
D. Test the Accuracy of Sales and Cash Receipts Transactions
   a. Join Sales Invoice, Shipping Log and Cash Receipts on Invoice-Num.
      i. Primary and Secondary keys: Invoice Num.
      ii. Primary and Secondary fields: “Add All”.
   b. Search for discrepancies between amount due and amounts paid using the following expression: Amount > 0
      AND Amount <> Amount-Due
   Result: Six records reveal discrepancies between amounts due and the amounts paid.
9.4 | Expenditure Cycle Internal Control and Risk Assessment Solutions

Based on the case description and the expenditure cycle flowchart (Figures 3):

a) Discuss GSW’s internal weaknesses.
b) Describe the unmitigated risk(s) associated with each control weaknesses.
c) Comment on the possible misstatement in specific accounts due each control weakness.

The following enumerated responses correspond to the numbered circles in the flowchart below:

1) No Purchase Requisition
   a) Internal Control Weakness: There is a lack of transaction authorization regarding James Smith. He is responsible to authorize and execute transactions. He determines the items that need replenishing and selects suppliers from the Vendor file, which he maintains.
   b) Unmitigated risks.
      . May order items that are not needed.
      . Ordering from non-approved vendors at higher than market prices.
      . Opportunity for fraud such as kickbacks and pass through fraud.
   c) Possible account misstatements:
      . Inventory overvalued.
      . Purchases excessive.

2) No blind copy of the Purchase Order
   a) Internal control Weaknesses: Here, GSW lacks segregation of duties. There is no formal receiving function to count and inspect inventory receipts. Also, no blind copy of the PO is created to control receiving process.
   b) Unmitigated risk: Because the clerk used the packing slip instead of a blind copy he may avoid actually counting or inspecting items being received.
c) Possible Account misstatements:
   - Inventory overvalued.

3) Inventory Custody
   a) Internal Control Weakness: The Warehouse staff have inventory custody and record keeping responsibility (previously discussed in revenue cycle).
   b) Unmitigated Risk: Because the warehouse clerks have access to the accounting records they may conceal inventory losses and thefts.
   c) Possible account misstatements:
      - Inventory understated.
      - Cost of Goods sold overstated.

4) Three-way match
   a) Internal Control Weaknesses: There is no independent verification. The accounts payable clerk does not perform a three-way-match, which reconciles the vendor invoice against the purchase order and the receiving report. This verifies that the company is only responsible for goods that were ordered and received.
   b) Unmitigated Risk: Because the clerk does not reconcile the invoice with the receiving report (only the PO), GSW may pay for items not received or for damaged goods.
   c) Possible account misstatements:
      - Accounts payable misstated.
      - Cash disbursement errors.
9.5 | Expenditure Cycle Substantive Tests (IDEA)

A. Test for Unrecorded Liabilities
   a. Join Purchase Order and Receiving Report on PO-Num, selecting “Matches Only.” Since the terms are FOB Destination, only received Purchase Orders are considered liabilities.
   b. Next, join the above file and the Voucher Payable file on PO-Num, selecting “All Records in Both Files”.
   c. Search for items received after 01/01/2017 and before 01/01/18 that are not included in Voucher Payable. These are unrecorded liabilities.

Result: The extraction returns 13 records with an Extended Cost value of 43,908.88.

B. Inventory Reported at Net Realizable Value (NRV)
   b. NRV is the lower of market price or cost of a product. To calculate this, we will create a virtual field to find the minimum value between these two parameters.
   c. In the Inventory Table, select Append (Data tab > Fields group). Enter the following:
      i. Field Name: Lower-Cost-Market.
      ii. Field type: Virtual Numeric.
      iii. Number of decimals: 2.
      iv. Parameter: select Min() function, using Value-at-Cost and Market-Value as Parameters; Execute to add the virtual field to the table.

Result: Inventory is overstated by 150,221.
Creating a Virtual Field containing the MIN function

Virtual Field Added to Table

Field Type

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Numeric Statistics</th>
<th>VALUE_AT</th>
<th>MARKET_V</th>
<th>LOWER_COST_MARKET</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Net Value</td>
<td>4.572,735.06</td>
<td>8.331,184.32</td>
<td>4.422,355.60</td>
</tr>
<tr>
<td></td>
<td># of Records</td>
<td>175</td>
<td>175</td>
<td>175</td>
</tr>
<tr>
<td></td>
<td>Positive Value</td>
<td>4.572,735.06</td>
<td>8.331,184.32</td>
<td>4.422,355.60</td>
</tr>
<tr>
<td></td>
<td># of Positive Hits</td>
<td>175</td>
<td>175</td>
<td>175</td>
</tr>
<tr>
<td></td>
<td># of Negative Hits</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td># of Data Errors</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td># of Valid Values</td>
<td>175</td>
<td>175</td>
<td>175</td>
</tr>
<tr>
<td></td>
<td>Average Value</td>
<td>26,156.14</td>
<td>36,121.84</td>
<td>25,271.74</td>
</tr>
<tr>
<td></td>
<td>Minimum Value</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>Maximum Value</td>
<td>797,304.00</td>
<td>3,376,354.12</td>
<td>797,304.40</td>
</tr>
<tr>
<td></td>
<td>Record # of Min</td>
<td>80</td>
<td>80</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Record # of Max</td>
<td>140</td>
<td>140</td>
<td>140</td>
</tr>
<tr>
<td></td>
<td>Sample Std Dev</td>
<td>76,448.25</td>
<td>117,082.83</td>
<td>74,207.44</td>
</tr>
<tr>
<td></td>
<td>Sample Variance</td>
<td>5,644,235.61</td>
<td>13,703,303.00</td>
<td>5,564,777,631.87</td>
</tr>
<tr>
<td></td>
<td>Pop Std Dev</td>
<td>76,229.54</td>
<td>116,747.83</td>
<td>74,207.44</td>
</tr>
<tr>
<td></td>
<td>Pop Variance</td>
<td>5,610,944.51</td>
<td>13,630,096.05</td>
<td>5,532,279,902.54</td>
</tr>
<tr>
<td></td>
<td>Pop Standard Dev</td>
<td>7.737647</td>
<td>9.406186</td>
<td>7.905079</td>
</tr>
<tr>
<td></td>
<td>Pop Kurtosis</td>
<td>66.213062</td>
<td>99.653740</td>
<td>71.645260</td>
</tr>
</tbody>
</table>
C. Accuracy of Payments to Vendors
   a. Join Chk Register and Voucher Pay on Voucher Num, selecting “All records in both files”.
   b. Testing for duplicate payments:
      i. Use the Duplicate Key option in the Explore Tab, using Voucher-Num as the selection key.
      ii. This should return 2 records where the Voucher-Num and Full-Amount are the same, but Chk-Num is different. This indicates a red flag for duplicate payments.
   c. Checks Written for incorrect amounts.
      i. Using the joined Check Register and Voucher Payable table, extract records where Chk-Amnt > 0 AND Chk-Amnt <> Disc-Amnt AND Chk-Amnt <> Full-Amnt.
      ii. Result: There are two vouchers with checks written for an incorrect amount.
9.6 | Expenditure Cycle Substantive Tests (ACL)

A. Test for Unrecorded Liabilities
   a. Join Purchase Order and Voucher Payable on PO-Num.
   b. Next, join the above table with Rec Report on PO Num, selecting all primary and all secondary records.
   c. Search for items received after 01/01/2017 and before 01/01/18 that are not included in Voucher Payable.
      These are unrecorded liabilities.
   Result: The extraction returns 13 records with an Extended Cost value of 43,908.88.

   ![Image of Excel sheet showing extraction results]

B. Inventory Reported at Net Realizable Value (NRV)
   b. NRV is the lower of market price or cost of a product. To calculate this, we will create a virtual field to find
      the minimum value between these two parameters.
   c. In the Inventory Table, select Edit > Table Layout > Add a New Expression Enter the following:
      i. Name: Lower-Cost-Market.
      ii. Default Value (click on the f(x) button): Select the minimum function and replace (number, number) with
         MINIMUM(Value-at-Cost, Market-Value).
   d. From Inventory table, right click and select “Add Columns,” select Lower-Cost-Market then OK.
      i. You should now see the new field in the table.
   e. Analyze > Total Fields on Lower-Cost-Market = 4,422,554.
   Result: Inventory is overstated by 150,221.

   ![Image of Excel sheet showing Lower Cost Market calculation]
C. Accuracy of Payments to Vendors
   a. Join Chk Register and Voucher Pay on Voucher Num, selecting “All primary and all secondary records”.
   b. Testing for duplicate payments:
      i. Analyze > Look for Duplicates, select Voucher-Num as the selection key.
      ii. Select fields to display and provide a name for output file.
      iii. This should return 2 records where the Voucher-Num and Full-Amount are the same, but Chk-Num is different. This indicates a red flag for duplicate payments.
   c. Checks Written for Incorrect Amounts.
      i. Using the joined Check Register and Voucher Payable table, Data > Extract Data to find records where:
         Chk-Amnt > 0 AND Chk-Amnt <> Disc-Amnt AND Chk-Amnt <> Full-Amount.
      ii. Result: There are two vouchers with checks written for an incorrect amount.

9.7 | Audit Tests to Detect Fraud (IDEA)

A. Test for Manipulated Sales Data.
   a. Perform a Benford’s Analysis on Sales-Invoice.
   b. See results below:
B. Test for Vendor Fraud.
   a. Join Employee and Vendor on Street, State, City and Zip selecting “Matches Only”.
   b. Results show that Employee 000190 has the same mailing address as Vendor 12788.
   c. Open Voucher Payable table and Summarize Full-Amount on VEN-NUM.
      i. This shows that Vendor 13788 has Accounts Payable in the amount of 330,863.36.
A detailed review of the 21 invoices reveals that the supplier invoice numbers are mostly sequential. This suggests that supplier 13788 has a single customer, which is GSW. The address similarities and the sequential invoice numbers are red flags. The auditor would need to report this to management and further investigate these transactions.

9.8 | Audit Tests to Detect Fraud (ACL)

A. Test for Manipulated Sales Data
   a. Open Sales-Invoice Table.
   b. Analyze > Perform Benford’s Analysis on Amount-Due.
B. Test for Vendor Fraud
   a. Join Employee and Vendor on Street, State, City and Zip selecting "Matches Only".
      i. Results show that Employee 000190 has the same mailing address as Vendor 12788.
   b. Open Voucher Payable table.
      i. Data > Summarize Full-Amount as field on VEN-NUM and provide a name for the output file.
      ii. This shows that Vendor 13788 has Accounts Payable in the amount of 330,863.36
References


**GSW Case Appendix A**

**Control Activities**

Control activities are policies, procedures and practices that management employs to mitigate identified risks to their organization’s assets and to ensure the accuracy of accounting information. This appendix describes a class of control activities called “physical controls”, which relate to human activities employed within accounting systems. These may be purely manual tasks, such as inspecting inventory receipts, or they may be computer-supported tasks, such as entering sales orders into a computer terminal for automated processing. Physical controls are classified into six subgroups: transaction authorization, segregation of duties, supervision, accounting records, access control, and independent verification (adapted SAS 109, 2006).

*Transaction Authorization*

The purpose of transaction authorization is to ensure that only valid transactions that are in accordance with management’s objectives are processes by the accounting information system. An example of transaction authorization is the task of authorizing inventory purchases only when needed. In many cases this is accomplished by the issuance of a purchase requisition, which then triggers (authorizes) a formal purchase order. Another example is to authorize sales only to those customers who are credit worthy and have undergone a credit check. The type and degree of the credit check will depend on the nature and materiality of the transaction in question. This may be simply to ensure that the transaction in question does not exceed the customer’s credit limit or it could involve extensive review of the customer’s financial situation.

*Segregation of Duties*

The cornerstone of physical controls is the segregation of duties to eliminate incompatible functions being performed by an individual. Depending on the specific tasks to be controlled, segregation of duties will take different forms. The following three objectives, however, provide general guidelines applicable to most situations.

**Objective 1:** The task of transaction authorization should be organizationally separate from the processing of the transaction. For example, the purchasing function should not initiate purchases until the inventory control function provides authorization (i.e.; a purchase requisition). If properly implemented this segregation of duties would reduce the risk of purchasing unnecessary inventory and lessen the opportunity to perpetrate certain types of fraud.

**Objective 2:** The tasks of asset custody and that of accounting for those assets should also be separated. For example, the department that has physical custody of finished goods inventory (the warehouse) should not also keep the official inventory records. When a single individual or department has responsibility for both asset custody and record keeping, the potential for fraud and errors increases; assets could be stolen or lost, and the accounting records falsified to conceal the event.

**Objective 3:** The segregation of duties should be such that the perpetration of a fraud would require collusion between two or more individuals with incompatible responsibilities. For example, no individual should have sufficient access to accounting records to perpetrate a fraud. Thus, journals, subsidiary ledgers, and the general ledger should be maintained separately.

*Supervision*

Some situations do not lend themselves to desired segregations of duties. This is often the case in small businesses that do not have sufficient numbers of employees to achieve adequate segregation of duties and also in larger firms where functional areas lack sufficient personnel. In such cases management compensate for poor segregation controls through direct supervision. For this reason, supervision is often called a compensating control.

*Independent Verification*

Verification procedures are independent checks of the accounting system to identify errors and misrepresentations. Verification differs from supervision because it takes place after the fact, by an individual who
is not directly involved with the transaction or task being verified. In contrast, supervision takes place while the activity is being performed. Examples of independent verifications include:

- Reconciling batch totals at points during transaction processing.
- Comparing physical assets with accounting records.
- Reconciling subsidiary accounts with control accounts.

**Accounting Records**

Accounting records are the source documents, journals, and ledgers that form an audit trail, which plays an essential role in the financial audit of the firm. The audit trail allows internal and external auditors to trace transactions from the financial statements to the ledger accounts, to the journals, and to the source documents.

**Access Control**

The purpose of access controls is to ensure that only authorized personnel have access to the firm’s assets. Unauthorized access can be either direct or indirect. Physical security devices, such as locks, safes, fences, and electronic alarm systems, control against direct access. Indirect access involves gaining access to the accounting records that control physical assets such as inventory or cash. For example, an individual with access to the relevant accounting records can destroy the audit trail associated with a particular sales transaction. Thus, by removing the records of the transaction, including the accounts receivable balance, the sale may never be billed and never paid.
GSW Case Appendix B

Fraud Schemes and Detection Techniques

The purchasing function is particularly vulnerable to fraud and, for many organizations, represents a significant area of risk. Billing schemes, also known as vendor fraud, are perpetrated by employees who exploit an employer’s accounting systems by submitting invoices for fictitious goods or services, inflated invoices, or invoices for personal purchases, forcing the company to issue payments to false suppliers (the employees). A preliminary step in this scheme requires that the perpetrator create a phony vendor company and establish it in the victim organization’s records as a legitimate supplier. The embezzler then submits fake vendor invoices to be processed by the AP function in the victim company. Depending on the organizational structure and internal controls in place, this type of fraud may involve collusion between two or more individuals. For example, a purchasing agent prepares a purchase order for items from the fake vendor, and a receiving clerk prepares a fictitious receiving report for the items. The AP clerk then receives these documents, which appear legitimate, and matches them to the phony invoice when it arrives. A liability is then recorded, and payment is subsequently made. In smaller organizations, a single individual with the authority to authorize payments can hatch a simpler version of the scheme.

Because of the need to falsify accounting records, billing schemes leave a trail in the underlying accounting data that the forensic auditor can follow if he or she knows what to look for. Even in small businesses, finding the telltale trail of fraud from within the masses of transaction data using manual procedures is virtually impossible. Thus, data analysis tools such as ACL and IDEA are essential. The fraud profiles of several fraud schemes and the audit procedures used to detect them are described next.

Sequential Invoice Numbers

A review of invoices from a legitimate vendor should normally show wide gaps in the invoice numbers because the vendor is billing many different customers. Since the victim organization in a vendor fraud scheme is the only recipient of these fabricated invoices, the invoices numbers “issued” by a careless phony vendor may actually follow an unbroken numerical sequence. Therefore, the auditor can use ACL or IDEA to sort the records in the invoice file by both invoice number and vendor number. This will highlight sequential records, which can then be retrieved for further review.

Vendors with P.O. Boxes

Most legitimate suppliers have a complete business address, however, since fake suppliers have no physical facilities, the perpetrator of the fraud may sometimes rent a P.O. box to receive payments by mail. Using the expression builder within ACL or IDEA, the auditor can create a filter to select vendor records from the invoice file that use P.O. box addresses. Since legitimate vendors may also use a P.O. box, this is not proof of fraud, but rather a red flag for further review to verify the legitimacy of the vendor.

Vendors with Employee Addresses

Rather than renting a P.O. box, a perpetrator may use his or her home address on the invoice. Although it is possible that an employee’s home-based business is a legitimate supplier, this is not typical and should be investigated. To test this, the auditor can use the join feature of ACL or IDEA to combine the Employee file and the Vendor file on the address fields as the common key for both files. Only records that “match” on these fields will be passed to the resulting joined file. These records should be reviewed further.

Multiple Companies with the Same Address

To divert attention away from excessive purchases made from the same vendor, a perpetrator may create several phony suppliers that share the same mailing address. To detect this, the auditor may use the duplicates feature available in ACL and IDEA to generate a listing of mailing addresses that are common to multiple vendors.
Invoice Amounts Slightly below the Review Threshold

Many organizations establish a financial materiality threshold to control disbursements. Payments of transactions below the threshold are automated, while those above it require a formal management review and approval. Knowing this, a perpetrator may falsify payments that fall just under the threshold to avoid detection and yet maximize his or her benefit from the fraud. The auditor can use the expression builder in ACL or IDEA to identify transactions slightly below the threshold to highlight suspicious activity.

Multiple Payment of Legitimate Invoices

The pay-and-return fraud scheme involves a clerk with check-writing authority who intentionally pays a legitimate vendor twice for the same invoice. The honest vendor, recognizing that the customer made a double payment issues a reimbursement check to the victim company, which the clerk intercepts and cashes. Evidence of such a fraud may be found by joining the Check Register file with the Voucher Payable file and searching for duplicate checks written for the same voucher number.

Manipulation of Accounting Data

Another form of fraud is to simply manufacture false transactions. This may be done to inflate revenue reported in financial statements or to inflate expenses on tax returns. A technique known as Benford’s analysis can be used to detect anomalies in data that might be due to fraud or simply clerical errors. This analytical tool is based on Benford’s Law, which states that leading digits in a financial string do not occur randomly. In fact, these values naturally follow a distribution in which the leading digit “1” occurs 0.3 of the time while the leading digit “9” occurs only 0.04 of the time. Benford’s Law is typically used on individual transaction files such as invoices payable and sales invoices to detect the over or under use of leading digits in the financial data. Auditors can use the Benford’s analysis feature in either ACL or IDEA to test the distribution of selected files for compliance with Benford’s Law.
Supplemental Accounting Concepts

Revenue Recognition
The GSW Sales Invoice file serves as the sales journal. As such, the total sales calculation for the period is derived from the Amount Due field of the Sales Invoice file. Not all of these invoices, however, should necessarily be included in the calculation. Since the case assumes FOB shipping point for sales transactions, only those items that have been shipped on or before the period end date constitute sales for the period. Identifying the valid sales transactions requires students to join the Sales Invoice File with the Shipping Log and screen out invoices that were not shipped or were shipped after the period end.

Accounts Receivable Calculation
Accounts Receivable are the sales invoices (captured in the “Revenue Recognition” description) that are still unpaid at the end of the period. To identify these unpaid items students must join the previously joined Sales Invoice-Shipping Log file to the Cash Receipts file and search for items that are still unpaid or paid after the period end.

Unrecorded Liabilities
The case assumes FOB destination for all purchases from vendors. Unrecorded liabilities are therefore items that were ordered (evidenced by Purchase Order record) and have been received (evidenced by a Receiving Report record), but for which there is no Voucher Payable record. Unrecorded liabilities are calculated by joining the Purchase Order, Receiving report and Voucher payable files. Those items missing a Voucher Payable record are unrecorded liabilities.

Bibliography

Dr. James Hall
James A. Hall is a Professor of Accounting at Lehigh University and is the co-director of the Computer Science and Business (CSB) program. Professor Hall has published articles in the Journal of Accounting, Auditing and Finance, Journal of MIS, Communications of the ACM, and other academic and professional journals.

Kallie Ziltz, MS
Kallie is a PhD student in Teaching, Learning and Technology (TLT) at Lehigh University. Drawing on her background in both Computer Science and Business (CSB) and Accounting, Kallie works with Dr. Hall within his IT Auditing, Accounting Information Systems and Computer Applications in Business courses.